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1 Introduction 

Thank you for purchasing IMF Studio Player, a software-based solution for 
playback and quality analysis of Interoperable Mastering Packages (IMPs). While 
IMF Studio Player was designed to be a quality assurance tool for checking 
packages before their final distribution, it may also be a perfect low-budget 
solution for screenings in your facilities. Bundling IMF Studio Player with IMF 
Studio Creator, an application for creating IMPs, Fraunhofer IIS offers 
everything necessary to benefit from the advantages of a digital post 
production workflow. 

IMF Studio Player handles video resolutions up to 4K at arbitrary frame rates as 
well as multi-channel audio, subtitles and captions. Furthermore it allows you 
to export your IMPs’ audio, video and timed-text content to allow for fast 
repackaging, creation of proxies for subtitling or transcoding into other 
formats. 
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2 Feature Overview 

 IMF 
Studio 
Player 

Demo 
Version 

GPU-based real-time decoding *, *** 9� 15 sec 

Software-based real-time decoding ** 9� 15 sec 

Playback of MXF, QuickTime, imfproj, JPEG 2000, TIFF, 
DPX, PNG, JPEG, GIF, BMP, PPM, M3U Playlists 9� 9�

Customizable color space conversion 9� 9�
Finely-tunable Quality-vs.-Performance Trade-off  9� 9�
Audio waveform visualization 9� 9�
Multichannel Audio Framework (MCA) 9� 9�
Multiple Timed Text Tracks (Text, PNG) visualization 9� 9�
Add external Timed Text (XML or MXF) on the fly 9� 9�
Timeline shows reel boundaries and timed text 9� 9�
HD-SDI output** 9� 9�
30 bit DisplayPort output*** 9� 9�
Stereoscopic playback 9� 9 
IMF playback & validation 9� 9�
IMF validation and creation of comprehensive report in 
HTML format 9� X 

Export to JPEG 2000, QuickTime, TIFF, DPX, WAV 9� X 

Dolby Vision 9� 15 sec 
 

Available for 64 bit Windows 10 9� 9 
Available for 64 bit Mac OS X (10.14-10.15)  9� 9 

*) Required graphics device setup described below 

**) Required hardware described below 

***) Windows only 



 
 

 6 of 77 23/02/2021 
 
 

 

3 System Requirements  

IMF Studio Player comes with a GPU-based JPEG 2000 Codec and a software-
based JPEG 2000 Codec. The GPU-based codec is only available for Windows 
and requires an additional graphics device. 

Provided the proper hardware is available, IMF Studio Player is capable of 
decoding IMPs (with up to 800 Mbit/s, 24 fps) in real-time.  

3.1 Software-based decoder 

In order to guarantee real-time playback with at least 24 fps, the software-
based decoder requires a fast multi-core CPU with at least four cores. It is 
recommended to download the demo version in order to find out how your 
system performs.  

The scalability of JPEG 2000 encoded images can be exploited to watch a 1K or 
0.5K resolution preview in real-time on systems that don’t have a sufficiently 
powerful CPU. Optionally you can choose to upscale the lower resolution 
preview to full-screen, without negatively impacting the maximum speed.  

3.2 GPU-based decoder (Windows only) 

For smooth playback in GPU-based mode, IMF Studio Player always requires a 
bundle of two graphics devices - a primary device for rendering (with 
OpenGL) and a secondary device for video decoding (with NVIDIA® CUDA®1). 
Using a sufficiently powerful graphics device pair, the GPU-based codec can 
provide real-time playback even for framerates above 24 fps or UHD IMPs with 
up to 800 Mbit/s. Both graphics devices should ideally be connected with PCIe 
x16.  

When using two NVIDIA® graphics cards (e.g. one for rendering and one for 
decoding with CUDA®), it might be necessary to explicitly configure the 
graphics card that should be used for rendering: NVIDIA® Control Panel -> 3D 
Settings -> Manage 3D settings -> Global Settings -> OpenGL rendering GPU -
> <select the graphics card that drives the display where IMF Studio Player's 
canvas is located>. 
This can make a significant difference in terms of render performance. 

  

                                                
1 CUDA® is a registered trademark by the Nvidia Corporation 
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Primary graphics device 

This device is dedicated to rendering video and optionally color post-processing, 
using OpenGL. Displays need to be attached to this device. It is recommended 
to install the primary device in the mainboard’s top slot. This device does not 
necessarily need to support the NVIDIA® CUDA®2 technology. 

In order for the 3D output option “Quad-buffered stereo” to be available, this 
device needs to support quad buffering (e.g. NVIDIA® Quadro®3 series). Using 
this technology, IMF Studio Player supports the use of active shutter glasses or 
Stereo over Dual-DVI. The graphics driver control panel can be used to specify 
how stereo images should be processed by the primary graphics card. 

In order for the “30 bit Colors” option to be available, this device as well as the 
connected display need to support 30 bit per color.  

When a HD-SDI output device is used and the option “Enable subtitling, color-
processing and scaling” is activated, images are also processed with the 
primary graphics card, before they are emitted to the HD-SDI device. In this use 
case, a NVIDIA® Quadro® series graphics card (e.g. Quadro K600) might also 
be beneficial for a better render performance. Otherwise, a mid-range 
NVIDIA® GeForce® device, e.g. NVIDIA® GeForce®4 GTX 750 Ti, is a good 
choice. 

Secondary graphics device 

This device is dedicated to the computationally very expensive JPEG 2000 
decompression. It must not be used as a video output, i.e. no display should be 
hooked up to this device. For best performance, this device should be a 
CUDA®-enabled graphics card (e.g. from the latest NVIDIA® GeForce® series) 
with many CUDA®-cores installed in the mainboard’s secondary slot. Please 
refer to www.easydcp.com for a list of supported devices. It should be 
connected with PCIe x16. PCIe x2, x4 or x8 will lower the performance 
significantly. Make sure to connect both on-board power connectors to the 
power supply unit and that the power supply unit meets the system’s 
requirements. 

                                                
2 CUDA® is a registered trademark by the Nvidia Corporation 
3 NVIDIA® Quadro® is a registered trademark by the Nvidia Corporation 
4 NVIDIA® GeForce® is a registered trademark by the Nvidia Corporation 
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4 Licensing 

4.1 Demo Mode Restrictions 

In demo mode,  

x Full-resolution playback is limited to 15 seconds. Afterwards, the quality 
is reduced and audio is muted. 

x Issues found while loading the IMP are not disclosed  

x The export module is locked 

x All tests of the validation module will not disclose their true result or 
any issues they might have identified 

4.2 License Activation 

Download IMF Studio Player at www.easydcp.com. 

4.2.1 Offline workflow 

After installing and starting IMF Studio Player the following dialog appears: 

 

Click “Demo / Offline Mode” to  start a free version of IMF Studio Player which 
is subjected to the demo mode restrictions listed in chapter 4.1. After startup 
has finished, open the options dialog, select “Activation Status” and press 
“Request License”. Fill in the licensee’s name. If the computer is connected to 
the Internet, click the “submit” button. The default web-browser will open 
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www.easydcp.com, where further instructions will guide you through the 
purchase process.  

After the purchase, a link to the zip file with the License will be available for 
download within your user account at www.easydcp.com. The zip file can be 
dragged & dropped into IMF Studio Player installation to unlock it. 

The procedure is also described in a screen cast at www.easydcp.com. 

4.2.2 Online workflow 

Purchase one of the available subscription plans at www.easydcp.com. After 
the purchase, a license for IMF Studio Player is linked to your easyDCP account. 

 

Install and start IMF Studio Player and fill in the username and password you’ve 
used for your easyDCP account. After clicking “Login”, IMF Studio Player will 
query the linked license from www.easydcp.com and activate your instance.  

The “Device Name” field is prefilled with the name of the machine you use IMF 
Studio Player on. You can change the name freely. The name will be send to 
easyDCP.com and is used for convenient device identification only. 

Please be aware that a permanent internet connection is required. As soon as 
IMF Studio Player detects a connection loss, the graphical user interface will be 
locked until the internet connection has re-established.  

 

With the online licensing workflow it’s possible to run IMF Studio Player on 
different systems with the same license. Please be aware that multiple 
subscriptions are necessary to run IMF Studio Player instances at the same time 
on different machines. 
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4.3 Application Data and Settings 

IMF Studio Player automatically creates an application data folder. It contains 
the settings file as well as a repository for color transform files. 

The folder is located at  
<User Application Data>/Fraunhofer IIS/IMF Studio Player/ 

Additionally, all IMF Studio applications share a folder with additional files such 
as color space descriptions. It is located at  
<User Application Data>/Fraunhofer IIS/IMF Studio Shared/ 

The user application data folder on Windows is in  
C:/Users/<username>/AppData/Roaming/ 

A shortcut is to just enter %APPDATA% into the address bar. 

On Mac OS X, the user application data folder is at  
\Users\<username>\Library\Application Support\  

4.4 Software Update 

Please make sure you leave the automatic check-for-updates enabled, so that 
you get informed immediately when new versions are available for download. 

Multiple versions of IMF Studio Player can be installed side-by-side, so there is 
no need to uninstall the old version before installing a new one. 

A new license file is only required for major updates, e.g. version 3.6 to version 
3.7, and can be purchased at www.easydcp.com. Point releases do not require 
a new license, e.g. 3.7.0 to 3.7.1.  

The update procedure is as follows 

Point Release (only the last version number changes, e.g. 3.7.0 to 3.7.1) 

1. Log into your account at www.easydcp.com 

2. Download the new installer file and install it 

3. Offline licensing workflow: The new IMF Studio Player version will 
automatically detect your existing license file and is good to go. 

4. Online licensing workflow: IMF Studio Player will automatically 
download the necessary license and certificate information from 
www.easyDCP.com as described in 4.2.2. There is nothing else you 
have to do. 
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Major Release (first or second version number changes, e.g. 3.6.x to 3.7.x) 

Offline licensing workflow 

1. Log into your account at www.easydcp.com and purchase the license 
for the new version. The installer is then available for download. 
Download and install it. 

2. Open the new IMF Studio Player version and proceed with the steps 
described in 4.2.1. 

Online licensing workflow 

If you have a valid subscription plan the installer of the new version can be 
downloaded at www.easydcp.com. All further steps are described in 4.2.2. 
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5 Playback 

When launching IMF Studio Player, a splash screen will be displayed during the 
start-up phase.  

This is the main window: 

   

5.1 Opening a IMP 

To open an existing package, click on the button with the eject icon in the 
bottom left corner.  
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For convenience you can also drag and drop supported sources directly onto 
the canvas, playlist editor or the playback toolbar, or onto the application icon 
to open a new instance. Supported sources are 

x one or more IMP folders 

x a CPL / Assetmap or PKL .xml file 

x a numbered file sequence (folder or first file) (see chapter 2 for 
supported file types) 

x *.mxf with audio and/or video essence 

x *.wav files 

x QuickTime files (*.mov, *.mp4, *.avi, *.mpg, *.mpeg) 

x a *.m3u playlist file  

x a IMP project file (*.imfproj), created with IMF Studio Creator 

 

If one or more packages were opened, the playlist editor will pop up. It lets you 
select  a single composition playlist for playback or arrange a playlist. You can 
always drag further assets into the playlist editor or re-open it from the context-
menu.  

For some of the fields, the tooltips contain more information or metadata like 
the creator, issue date, etc. You can also browse the XML or MXF files, or 
expand/collapse all items. 
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5.2 Opening a Supplemental package (VF) 

A supplemental package (typically ends with “_VF”, which stands for Version 
File) is an add-on container that does not contain all the track files it references, 
but relies on the presence of an additional package (typically one that ends 
with “_OV”, which stands for Original Version). 

Often, the folder that contains the VF, resides within the folder that contains 
the OV, but other times, the two folders are located next to each other on the 
same level.  

If a folder with an OV is opened, IMF Studio Player will automatically detect any 
additional VF packages located within the folder and load them as well. 

When only the VF is loaded into IMF Studio Player, the original location of all 
those track files that are not contained in it, is unknown. These track files, as 
well as the whole Composition is drawn in grey.  

When the corresponding OV package is also loaded into IMF Studio Player, it 
will automatically resolve all missing references from the VF against the OV and 
the VF will become available.  

5.3 Opening Audio/Video File 

To open an existing media essence other than a IMP package (e.g. audio file, 
video file(s)), click on the button with the eject icon in the bottom left corner. 

 

Here you can select single video and/or audio files. Currently supported video 
sources are numbered file sequences (select first file of the sequence), DCI/IMF-
compliant MXF files with JPEG 2000 content or QuickTime files (*.mov, *.mp4, 
*.mpg, *.mpeg, *.avi).  

Currently supported audio sources are wave files (*.wav) with uncompressed 
PCM samples or DCI/IMF-compliant MXF files with uncompressed PCM 
samples.  
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The IMF Studio Player edition also supports encrypted MXF files. When an 
encrypted MXF file is selected, a button with the key icon will become visible, 
allowing you to enter the decryption key. Content keys for individual encrypted 
MXF files are not looked up in the repository. You will always have to re-enter 
them, either by entering the key manually, or by re-ingesting the corresponding 
content key file (IMF Studio Digest). The “OK” button will only be enabled 
when all fields are either empty or contain a valid essence. 

For convenience, supported file formats can also be dragged onto the IMF 
Studio Player canvas or playlist editor. 

 
Both video channels are required to have matching technical properties like edit 
rate and resolution. The shorter channel’s duration will be used as the overall 
duration.    

5.4 Opening and Creating a Playlist 

IMF Studio Player has limited support for playlists. Currently, only the m3u 
format is supported. To open an m3u file, drag and drop it onto the canvas or 
the IMF Studio Player icon. Items will be played back to back. Enabling the loop 
button will cause the whole playlist to be looped, not individual items. Playlists 
may be nested, but not recursively nested. 

A playlist can be created from within the Playlist Editor, with the “Save Playlist” 
option. The simplest form of a m3u playlist is a text file with one absolute path 
to a source asset per line. Optionally, each line may be preceded by a line with 
metadata that starts with “#EXTINF:”. It is followed by a number that denotes 
the maximum number of seconds the asset shall be played. A negative value or 
zero indicates that the full length shall be played. If the asset is shorter than the 
provided duration or the IMF Studio Player demo’s maximum playback duration 
limit is reached, the duration stated in the playlist is ignored. Following the 
duration, separated by a comma, a title needs to be specified. However, IMF 
Studio Player will continue to display the asset’s title and not the one stated in 
the playlist. A proprietary extension is that an additional, comma-separated, 
field, stating the audio volume, can be supplied. Valid values are numbers 
between 0-100. All blank lines and lines that start with “#”are ignored. 
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Sample: 

 

 
5.5 Opening an IMP with multiple virtual audio tracks 

A segment of an IMP may contain audio, picture and/or timed text. 
Furthermore a segment can contain a sequence of multiple tracks of the same 
essence (e.g. picture) that will be played back-to-back. In the screenshot below, 
the first segment has a sequence of eight tracks that will be played back to 
back. 

 

#EXTM3U 
 

# play only first 5 seconds 
#EXTINF:5, title 1 
\\server\IMFs\sample IMF\cpl.xml 

 
# play at 50% audio volume 
#EXTINF:0, title 2, 50 
\\server\FileSequences\j2c\img_00.j
2c 
C:\IMFs\sample IMF\video.mxf 
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Another concept in IMF packages is that of virtual tracks. In the screenshot 
above, the composition has two alternative virtual audio tracks – one with 
stereo channel audio and another one with 5.1 audio. The active virtual tracks 
are printed in bold.  

 

When opening the composition, the first virtual track will initially be opened. 
Subsequently, any other audio track can be selected by clicking the speaker 
icon in the toolbar. 

5.6 Playback control 

  Play/Pause Playback: 

Starts or pauses playback of the currently loaded media asset (hit ‘Space’).  

 Loop Video: 

When this option is activated, the currently loaded playlist will be restarted 
from the beginning when it reaches the end. 

 

f Discard resolution level: 

By clicking this button, a resolution level of the JPEG 2000 code-stream will be 
discarded. Discarding a resolution level will half the resolution in both 
dimensions, while speeding up decompression times. Discard a resolution level, 
if the picture essence cannot be played back in real-time. 

e Add resolution level: 

By clicking this button, an additional resolution level of the JPEG 2000 code-
stream will be added. Adding a resolution level will double the resolution in 
both dimensions while slowing down decompression times. 
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As seen above, an IMP contains multiple embedded resolutions. 

 Fit to Window 

This button is grouped with the resolution level buttons as well as the combo 
box listing all accessible embedded resolutions. Normally, the application 
window resizes itself to the decoded video resolution, which is always visible in 
the drop-down combo box displayed above. If the window is too small to fit 
the video resolution, scroll bars appear. When the “Fit to Window” button next 
to the combo box is checked, however, the displayed video resolution will be 
artificially scaled to optimally fit the current window size. Tip: In order to speed 
up the decompression, discard one resolution level and scale the resolution 
back up to full screen by enabling the “Fit To Window” option. The loss in 
quality may be acceptable in some cases.  
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The above screenshot shows the same 512x214 pixels embedded resolutions, 
but with the “Fit to Window” option enabled. 

M Full screen 

This button toggles the full screen mode of the video canvas. With the arrow 
button next to it, it’s possible to configure the target display device for full 
screen. 

Frame number 

 

Enter a value to directly jump to a specific frame number of the currently 
loaded asset. You can also use the blue slide bar to jump to a specific location.  

Frames per Second 

 

Arbitrary frame rates can be specified. If the audio edit rate is known (as is the 
case when playing an IMP or MXF), audio will only be played for the original 
edit rate. If a fractional frame rate is specified, the time code display will round 
to the next even integer. Hence, the time code no longer matches the world 
time. 
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 Timed Text 

 

The currently opened package’s timed text tracks can be shown or hidden. 

SDI HD-SDI output device  

Select whether or not the video should also be played out over an SDI device. 
Support devices are Blackmagic Design UltraStudio, DeckLink or Intensity series 
devices. Advanced SDI options can be configured in the options dialog as 
described in chapter 8.3. 

 Color Transform  

Setup the color spaces of the currently opened asset as well as of the computer 
monitor and/or SDI monitor. Please refer to chapter 5.8 for more details. 

 Export 

Export or unwrap the currently opened asset. Please Refer to chapter 6 for 
more details.  

 Validate 

Run a set of quality tests on the currently opened IMP and create a validation 
report. The button is only available when an IMP is opened. 
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 Audio 

 

Within the audio popup it’s possible to select the active track of the currently 
loaded asset (please refer to chapter 5.5) and the input and output audio 
channel mapping. 

For more details about output channel mapping, please refer to chapter 8.2, 
and for audio routing in general to chapter 9. 

Media Slider 

The timeline displays the playback progress of the current playlist item. 
Hovering over it will display additional information, clicking will jump to the 
associated time code. If the currently playing asset contains subtitles, markers 
will be drawn on the timeline at the fade-in points of all subtitle entries. 

 

Multiple reels inside a single package will be drawn in slightly different colors 
for easier distinction. Additionally, the context entries in Playback->”Jump to” 
allow navigation between reels, subtitles or playlist items.  

Timed texts are visualized as thin vertical bars. When hovering over a subtitle 
with the mouse cursor, the tooltip will display the text.  
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5.7 Adding external subtitle files 

IMF Studio Player can also load external subtitles on-the-fly via the playlist 
editor window. To do so, right click the desired package and choose “Add 
subtitle file(s) to Composition” or “Add subtitle file(s) to Segment”. Drag & 
Drop is supported as well.  

  

Please note that it makes a difference whether you  drop the subtitle on the 
composition or on a particular reel. In case you selected to add the subtitle file 
to the composition and its length exceeds the duration of the first reel, the 
remaining subtitle contents will be added to the following reels (if any). When 
you later unwrap the package in the Export dialog (see chapter 6), the single 
imported subtitle file will then be split up into multiple files (one for each reel). 
“Add subtitle file(s) to Reel” will only affect the selected reel. Make sure that 
the subtitle contains no entries beyond the reel’s end.  

To remove an external subtitle element, right click it and choose “Remove 
Subtitle” from the context menu. 

You may add multiple subtitle files at the same time. 

In order to distinguish them from regular ones, external subtitle elements in 
the playlist editor are displayed in italics. 

IMF Studio Player will automatically monitor external subtitle files for changes 
and update them accordingly (e.g. in case you modify the wording in an 
external editor) 
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5.8 Color Transforms 

  

With this button you can select a color transform. Enabling a color transform 
results in a better representation of how colors and “look” appear on the 
screen. Multiple standard color transforms are included with IMF Studio Player. 
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Color Transform Presets 

Color transforms are of the form “source space -> target space”. Each 
transform is represented by a file in the color transform repository. They use a 
proprietary XML format. The files can be edited and new ones can be added. 
These types of color transforms are still available for backwards compatibility. In 
the screenshot above, select the “Color Transforms / 3D LUTs” group box. The 
repository can be opened by clicking the folder icon. New files or 3D LUTs 
(*.3dl) can be added with the plus icon. 

Color Space Presets 

A more flexible way to define color transforms is by individually assigning 
source and destination color spaces. The source color space is specific to the 
currently loaded package and will be restored the next time the package is 
loaded. The first time a package is loaded, the source color space will be 
automatically inferred from the metadata. The destination color spaces can be 
individually selected for the computer monitor and for the SDI monitor. These 
selections will be permanently maintained. The color spaces are also 
represented by files that are located in the color space repository. The files are 
stored in a proprietary XML format that is different from the one used for the 
legacy color transform files. This repository is shared by both IMF Studio Player 
and IMF Studio Creator. Existing presets can be edited and new ones can be 
created. When adding new files, please make sure to assign a unique name. 
The “comment” attribute will be displayed as a tool tip. When creating a new 
preset it is recommended to copy and paste any of the existing presets and 
make adjustments as opposed to starting from scratch. All possible values can 
be looked up in the “template.xml.example” file located in the repository. 

ICC Profile 

Optionally, a separate ICC profile file can be referenced. This works with both 
the color transform and color space formats. The profile file needs to be 
located in the same folder. This profile will then be embedded when exporting 
QuickTime or TIF files to enable proper downstream color management.  
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Example: IMF 

 

As seen above, images look greyish or greenish, when displayed in the 
package’s native X’Y’Z’ color space with 2.6 gamma and P3 white point. When 
viewing on a computer monitor with the sRGB color profile, the colors need to 
be converted into the sRGB color space. 
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5.9 Safe Areas 

IMF Studio Player can overlay “Title Safe” and “Action Safe” areas as well as 
the DCI containers Flat, Scope and Full.  

 

Each preset is based on an XML file that are located in a directory which can be 
opened by selecting “Open Repository”. The “Title Safe”, “Action Safe” and 
“Center” presets are defined by specifying coordinates relative to the image. 
The remaining presets, on the other hand, are defined based on absolute 
coordinates. Based on the presets it should be straight forward to add 
additional custom presets, when required. They can either be copied into the 
directory where they will be detected by IMF Studio Player after a restart or 
they can be imported by selecting the “Add new preset…” option. The colors 
or thickness cannot currently be changed. The overlays cannot be burnt into 
the image when exporting the IMF package.  
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5.10 Timeline 

The timeline module can preview picture, sound and timed text tracks of a 
loaded composition. 

You can open the timeline in IMF Studio Player pressing keys “CTRL + T” or 
using the menu “View -> Timeline”.  

 

Time Code Edit 

The time code on the left side of the timeline is clickable and allows to jump 
directly to a specific time code. When it is selected it becomes blue and accepts 
all keys from 0 to 9. Pressing enter will accept the input and jump to the 
position in the timeline. It is also possible to start the editing via Ctrl + G after 
clicking the timeline once. 
 
f e Zoom: 

The two zoom buttons and the zoom slider control the zoom level of the 
timeline. Additionally zooming is possible with “CTRL / CMD + mouse wheel” 
while the mouse is over the timeline. 

 Zoom to fit: 

Shows the entire timeline in respect to the available space in the user interface. 

 Snap to clip borders: 

Helps to properly align the playhead at the clip borders. 

J Center view on playhead: 

Auto-aligns the timeline so that the play head is placed in the center. 

j Render Reels / Segments: 

When active, reel / segment borders will be shown in the timeline header. 
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L Render picture thumbnails: 

When active, thumbnails will be rendered for all video tracks in the timeline. 

K Render waveform thumbnails: 

When active, a visual representation of each audio track will be displayed in the 
timeline. Depending on the length of the audio tracks the rendering of the 
waveform for the first time can take a while. 

Navigation 

Using arrow key left and right allows for frame wise stepping in the timeline as 
it does for Player in general. With arrow up and down it is possible to jump to 
the next/previous reel/sequence in the composition. 
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5.11 Video Scopes 

 

The video scopes module provides an alternate representation of the video 
frames in real time during playback. They represent the channel wise (RGB) 
distribution of intensity levels. This option can be found under “View” -> 
“Video Scopes”. 

There are three video scopes provided, namely: 

1. RGB parade 

2. Waveform 

3. Histogram (Windows only) 

All of them provide a comprehensive representation of the video material 
rendered on the video canvas. 

RGB parade: This scope represents the spatial color intensity distribution of the 
component channels R, G and B across the frame. The horizontal axis 
represents the image width itself, divided into three parts, one for each color 
channel. The vertical axis represents the intensity levels for the current asset, 
based on its bit depth. The intensity distribution across channels in the video 
frame can be compared with the parade scope. 

The following figure illustrates the RGB parade. The red, green and blue 
channels are rendered in the respective colors. In this example, it can be seen 
that the intensity level of blue is slightly lower than that of red and green. It can 
also be seen that the intensity levels of red and green are higher to the left of 
the frame, which can be clearly understood by comparing with the actual 
frame rendered on the canvas. 
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Waveform: The waveform scope is similar to the RGB parade, with R, G and B 
components overlapped. The horizontal axis represents the image width and 
the vertical axis represents the intensity levels based on the bit depth of the 
asset. There are 2 modes – RGB and L (luminosity). The intensity option ranges 
from 0 to 100%. The intensity of the waveform scope can be adjusted using 
the provided spin box. 

The waveform scope is similar to the RGB parade. We have all the channels 
superimposed together into a single waveform scope to obtain a collective 
representation of the color distribution in the current frame. The figure below 
illustrates the waveform scope. The horizontal axis represents the image from 
left to right. It can be seen that the rendered frame has an overall yellow tint, 
which can be verified by comparing it with the waveform scope. 
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Histogram (Windows only): The histogram provides an overview of the 
intensity distribution in the video frame. The horizontal axis represents the 
intensity levels based on the bit depth of the current asset. The vertical axis 
represents the number of pixels with a particular intensity level / bin. There are 
five types of histograms available, namely: 

1. R – red channel 

2. G – green channel 

3. B – blue channel 

4. RGB – combined R, G and B channels 

5. L – Luminosity 

The histograms provide intensity distribution across a single color channel or all 
of them combined. The “Boost factor” is provided to amplify the visibility of 
histogram entries. It ranges from 1 to 200. Similar to the other scopes, the 
intensity levels are indicated in addition to the lower and upper legal limits. 
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The below figure demonstrates the video scopes for a video frame in two 
different scenarios. The left one is with a full range color (ITU-R BT.709 Full-
Range) and on the right hand side, it is in legal range (ITU-R BT.709). Thus, the 
video scopes can be used as a tool for quality check with respect to the color 
intensity ranges. 
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6 Export 

IMF Studio Player allows exporting a source’s video, audio or timed-text assets.  

The individual video frames can be unwrapped and saved as JPEG 2000 images 
(*.j2c) or decoded to uncompressed DPX, uncompressed TIF or a QuickTime 
container using any of the available installed QuickTime codecs. When 
exporting decoded images, various image processing options can be applied. 

IMF Studio Player’s export process is divided into a wizard. The necessary steps 
will be explained in the following sections. 

6.1 Mode selection 

 

Unwrap package and create IMF Studio project: IMF Studio Player can 
simply unwrap the whole IMP track file by track file. It will automatically 
generate an IMF Studio Creator project file, which can be opened with IMF 
Studio Creator to generate a new package. Regenerating the exported IMP will 
be almost as fast as a copy operation since image files are already in the proper 
format and a time-consuming JPEG 2000 compression is not necessary. Just 
make sure that IMF Studio Creator is configured to (1) disable JPEG 2000 re-
encoding, (2) disable automatic pillar-/letterboxing, (3) bypass the video track 
files’ color transform. This option requires that keys were ingested for all 
compositions as it will unwrap the whole package. When extending an existing 
package, e.g. by adding subtitles, this option should usually be preferred over 
the “Export sequence” option.  
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Create supplemental IMF Studio project with external subtitles: This 
option is only available if external subtitles were loaded. Exporting in this mode 
will create a IMF Studio Version File (VF) project file to be opened by IMF Studio 
Creator. The project will reference all track files from the original package. Any 
externally added subtitles will be split into reels and converted to SMPTE or 
Interop, when necessary. During the conversion, any subtitle attributes that use 
the default values defined in the specifications will be stripped. 

Export Sequence: This option can be used to export a package’s content into 
image and audio files. However, it will skip the reels’ invisible frames, e.g. when 
the movie has a run-in. To work around this, it is also possible to load a 
package’s MXF files individually and unwrap those one by one. This is 
effectively what the “Unwrap IMP” option does. 

6.2 Range Selection 

 

File Name Prefix: Will be used as the base file name. As a quick setting, the 
CPL title can be used as prefix. It’s also possible to define a custom prefix. All 
available options can be shown via the i  button. 

In- and Out-Points: Start and end points can be specified in terms of frame 
indices or reel indices. Exporting reels comes in handy when creating proxy file 
sequences to be used during the subtitling process, because subtitle files have 
to be provided individually for each reel. 

Preview: The preview displays the first and last frame based on the configured 
range. For convenience, a few frames in between the configured range will be 
shown as well. 
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6.3 Video Settings 

 

Resolution Level: JPEG 2000’s scalability by resolution can be utilized to 
export proxy sequences.  

File Format: JPEG 2000 (unwrap only), DPX, TIF or QuickTime. “Check (decode 
only)” is a quality assurance feature. It will decrypt and decode all frames in the 
package as fast as possible, verifying that the JPEG 2000 files are decodable, 
contain the proper profile flags and don’t violate the maximum bitrate assigned 
to the asset (250 Mbit/s by default). 

Codec: When exporting to QuickTime, any of the installed QuickTime codecs 
can be selected (Audio and Video). 

Scaling/Letterboxing: When exporting to QuickTime, the source can 
optionally be scaled and/or letterboxed. When enabled, the image will be 
scaled until either the width or height matches the desired resolution. If the 
output aspect ratio is different from the source, the remainder will be letter-
/pillarboxed.  

Color Transform: Any of the XML-based color transforms can be applied 
during the export. Please note, that this will impact the decoding performance. 

Mastering / Target Display: In case an IMP with Dolby Vision metadata was 
selected for export, the color transform controls will be replaced by controls for 
selecting a Dolby Vision Target Display. For more information about Dolby 
Vision, please refer to chapter 8.5. 

Color Depth: For DPX, bit depths of 8, 10 and 16 bits as well as the native bit 
depth can be selected. Choose 10-bit for the highest compatibility with other 
tools. For TIFF, bit depths of 8 and 16 bits as well as the native bit depth can be 
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selected. Export to QuickTime is restricted to 8 bits or 16 bits per color. The 
option to export to QuickTime in 16-bit mode will only be present when the 
source material actually exceeds a bit depth of 8 bits. 

Chroma Subsampling: When exporting chroma-subsampled source material 
(i.e. in 4:2:2 or 4:2:0 configurations) to DPX or TIFF, 4:4:4 or the native 
subsampling scheme can be selected. In case 4:4:4 is selected, the video 
material will be up-sampled accordingly. 

Burn-In Subtitles: Any of the present timed-text tracks can be embedded into 
the image. Optionally, the subtitles’ original positions can be shifted vertically. 
This comes in handy when creating new subtitles: a proxy file with the original 
subtitles burnt-in can be provided to the subtitler, who can add a new 
translated subtitle track and position it comfortably. 

Burn-In Timecode: Allows to burn in the time-code. 

Burn-In Text: Allows to burn in a static text, e.g. “Property of Fraunhofer”. 
Clicking the “…” button, will pop up an editor dialog that provides more 
space. 

Preview: The preview displays all frames which will be used for export based 
on the configured range on the previous export wizard page. Furthermore, the 
preview reflects all settings made on this export wizard page (except “Scaling / 
Letterboxing”). 

Please be aware that preview of Dolby Vision content is currently not supported 
in preview. 
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6.4 Audio Settings 

 

File Format: Audio essence can be stored as a single multi-channel WAV file, 
multiple single-channels WAV files or a in a QuickTime container. When the 
target wav-file exceeds the limit of 2GB file size, it will be split into multiple 
files. If both audio and video essence is exported using the QuickTime format, 
data will be interleaved into a single container file. Please note that depending 
on the selected codec, not all audio channel layouts might be supported. 

Input Channel Order and Output Channel Mapping: Configure the audio 
input channel order and output channel mapping for export. To do so select a 
preset from the existing list or click on the edit button next to “Input Channel 
Order” or “Output Channel Mapping” to define own presets. Please refer to 
chapter 9 for detailed information. 



 
 

 39 of 77 23/02/2021 
 
 

 

6.5 Summary 

 

At the end of the export wizard a summary will be displayed. The bottom 
section displays the corresponding arguments to export the currently loaded 
asset via command line. Please refer to chapter 10 for more information 
regarding the available command line interface. 
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7 Quality control 

Before distributing a IMP, it is highly recommended to run both the hash check 
and the validation test (both explained below). When running these tests, the 
package should be loaded not from the local drive, but directly from the mobile 
hard-drive.  

7.1 Log/Issue Reports  

When a new asset is loaded, IMF Studio Player automatically executes 
numerous checks, identifying potential issues related to integrity, formatting 
and security. The results are collected and presented to the user in a log 
window.  

 

The user should always read the error or warning messages very carefully. 
Issues are presented in a hierarchical tree. Typically, the lowest level contains 
the most detailed error message. The bottom half of the window shows all 
details of the highlighted issue. Each log entry has a severity level: Info, 
Warning or Error.  

Info: Feedback to the user or general log entries are classified as info. 

Warning: Issues that might result in the IMP not working on some servers, but 
that IMF Studio Player can still cope with are classified as warnings.  

Error: If IMF Studio Player cannot continue to process the asset, an issue is 
classified as an error. 
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The whole log can be saved as a *.HTML or *.XML file using the “Save As” 
button in the tool bar. When turning to the IMF Studio technical support with a 
question regarding a specific issue listed in the log, please attach the file. 

 

By default, the log window appears whenever a new Warning or Error was 
added to the log. By disabling the “auto-appear” checkbox in the top right 
corner, the window will be kept hidden until it is manually popped up using the 
context menu -> Log Window option (or press STRG/CMD + L). Disabling the 
auto-appear option is not recommended. 

The MXF hash values are not checked automatically, since this would be too 
time consuming. Please refer to chapter 7.3 for details on how to apply a hash-
check on a single package or the whole playlist.  
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7.2 Metadata Inspector 

The Metadata Inspector can be opened via “context menu -> Asset -> 
Metadata Inspector” or by pressing “I” on the keyboard. It gives information 
about the current asset’s general properties as well as audio- and video-specific 
properties. Each field is explained in its tool tip. The video properties 
“Resolution” and “Bit Depth” contain data that is listed individually for each 
color component. 

Additionally, the same information is available by clicking on  next to a 
playlist item.  
 

 

7.3 Validator 

The validator module can be used to automatically search for a range of 
potential issues in an IMP. The validation is split up into many individual tests. 
Tests are executed one after the other. Some tests only take a split second (for 
instance: check if all files exist) while others may take a while (for instance: 
check if all JPEG 2000 images can be decoded). 

It’s also possible to validate supplemental packages (without the corresponding 
OV). 
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Please be aware that only feasible tests will be executed. For example, if the VF 
references picture tracks from the OV, the JPEG 2000 codestream test will be 
skipped. The test will be skipped as well, when the KDM for decryption is not 
available. 

 

Once a test was executed, it gives a result that is either Success, Warning or 
Failed. When selecting a test, more details can be found in the bottom section 
of the validation dialog. A tree of events will describe what the test has done 
and each entry in the tree can in turn be selected to see its details in the dark-
grey text edit below. It is often not possible to foresee whether an issue will 
cause the IMP to be rejected by a cinema server or another tool in the 
production chain. For this reason we encourage the user to even take warnings 
seriously. 

 

The result of a validation run is always stored as a report in HTML format. By 
default, the file will be named after the folder that contains the IMP and be 
located next to it. Also, the overall test result will be included in the file name:  



 
 

 44 of 77 23/02/2021 
 
 

 

 

By clicking the cogwheel icon next to the “Save Results to Directory” field, the 
default behavior can be changed so that the file be located inside the IMP 
directory and/or that the overall validation result not be included in the 
filename.  

 

The validation report is separated into six sections:  

x General Information – contains top-level metadata on the package, 
the test result and the computer and IMF Studio version where the 
validation was carried out. Custom annotations that the user entered 
into the validation dialog’s “comment” field will also be added to this 
section.  

x Composition Playlists – lists technical properties (such as duration, 
resolution, package type, IMF application, JPEG 2000 profile, audio 
layout, etc.) individually for each composition.   

x Quality Report – contains all the test results and details in an 
interactive view. 

x Recommendations – in contrast to Quality Report, this interactive view 
contains results and details of all recommended test. The test results of 
these tests do not influence the global test result. 

x JPEG 2000 Bitrate Analysis – contains an interactive plot of the 
bitrate in Mbit/s over time for each CPL. Additionally, some statistics 
such as peak and average bitrate or the time code of the largest frame 
are stated.   

x Files – lists the content of each XML file as well as the metadata of 
each MXF file in the package. If the package is a supplemental package 
(version file - VF) and the original version (OV) was also loaded, both 
packages’ files are listed.  

x Directory Snapshot – lists of all files (including those that don’t 
belong to the package) within the folder or any subfolders of the 
package, including the file’s size in Bytes and date of its last 
modification. Paths are stated relative to the package’s root folder so 
that names of the user’s local or network repository are not disclosed.  

IMP: C:\MyImps\AliceWonder_FTR-1_S_EN-LAS_US-13_51_2K_DI_20060607_TDC_OV\ 
 Report: C:\MyImps\AliceWonder_FTR-1_S_EN-LAS_US-13_51_2K_DI_20060607_TDC_OV –  
           IMF Studio Validation Report (Success).html 

 

IMP: C:\MyImps\AliceWonder_FTR-1_S_EN-LAS_US-13_51_2K_DI_20060607_TDC_OV\ 
 Report: C:\MyImps\AliceWonder_FTR-1_S_EN-LAS_US-13_51_2K_DI_20060607_TDC_OV\  
           AliceWonder_FTR-1_S_EN-LAS_US-13_51_2K_DI_20060607_TDC_OV - IMF Studio  
           Validation Report.html 
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The overall result of the validation is  

x Failed – if at least one test found an error  

x Warning, if at least one test found a warning or has been deliberately 
disabled by the user (by clicking the check box next to the test in the 
validation dialog), and no test found an error 

x Success – if all tests were executed and none of them found any 
potential issues (warnings or errors) 

The quality report shows the results and details of all tests. When selecting a 
test, details are shown in the dark grey box on the bottom. In the below 
example, the test result is a warning, because the tests was deliberately 
disabled by the user by deselecting it before the start of the validation. 
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The Bitrate Analysis tab gives information on the JPEG 2000 bitrate. Every 
IMP is subject to a maximum bitrate that should never be exceeded. For IMPs 
the maximum bitrate depends on the JPEG 2000 profile employed and goes all 
the way up to 800 Mbit/s for lossy IMPs. IMF Studio Player will infer the 
maximum bitrate based on the package type and JPEG 2000 profile. If the user 
knows that the maximum bitrate for a particular IMP has been assumed 
incorrectly, they can manually change it in the Playlist Editor.  

JPEG 2000 is a highly data-dependent image compression scheme, though. If a 
particular image is easy to compress, e.g. because there are not a lot of details 
in it, then the maximum bitrate will not be reached. Only images with many 
details (or a lot of noise) will have to be capped in order not to exceed the data 
rate. The bitrate computed by IMF Studio is based only on the size of the 
decrypted JPEG 2000 file (i.e. without MXF overhead) and is converted from 
bits to Megabits using 103 (1000) as demanded by the specifications - and not 
210 (1024). For this reason, a tolerance can be configured in IMF Studio Player’s 
option pane for the CPU-based decoder.  

The diagram plots the bitrate over the time for each CPL. The plot is zoomable 
via the mouse wheel. 
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The validation can also be triggered from the command line. This way it is also 
easy to batch-validate an existing collection of IMPs.  

Below is an example of Windows Batch file for validating all IMPs in a given 
folder:  

 

@echo off 
pushd \\networkstorage\MyImpRepository 
set IMF StudioBin=C:\Program Files\Fraunhofer IIS\IMF Studio Player 4.0.0\bin\IMF 
Studio  
  Player.com 
 
for /f "tokens=*" %%D in ('dir /S /B /A:-D assetmap*') do ( 
  echo Validating %%D 
  echo. 
  "%IMF StudioBin%" "%%D" -validate -o C:\\Reports 
  echo. 
) 
popd 
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For more details on how to use IMF Studio Player from the command line, 
please refer to chapter 10. 

7.4 Photon 

The Photon module allows the validation of the currently opened IMF package 
by using Netflix’s Java based implementation of the IMF standard (please see 
https://github.com/Netflix/photon for more information). 

 

The Photon module requires an installed version of the Java runtime 
environment. If no Java runtime environment is installed, IMF Studio Player 
displays a corresponding error message.  

 

7.5 Hash Checker 

When loading a package, IMF Studio Player will validate file sizes of all files. 
However, it will only validate the XML files’ hash values. A file hash validation 
of the remaining files in the package has to be manually triggered by the user 
since it takes too long to be done automatically, especially for large files. Before 
distributing a IMP, the hash values should be checked. To do this, it makes 
sense to load the package directly from the mobile hard drive. Select “Check 
File Hashes” in the context menu or press “H”. If a package has been loaded, 
all asset files and their reference hash values will be listed. Click “Check 
Hashes” to start the hash value calculation. 
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In order to calculate hash values for arbitrary other files, drag & drop the file 
into the “Hash Checker” dialog.  

A hash value validation succeeds if the calculated hash value is identical to the 
reference hash value listed in the IMP. The “status” column will then display a 
green “Ok”. 

IMF Studio Player also has a command-line parameter to perform the hash 
check. Please refer to chapter 9 for more information. 

7.6 Audio Meters 

The audio meters module visualizes the audio processing of the currently 
opened asset by considering the configured input and output channel mapping 
(please refer to chapter 9) and the available channels of the currently 
configured audio output device. 

 

  



 
 

 50 of 77 23/02/2021 
 
 

 

8 Preferences 

8.1 Video Rendering 

IMF Studio Player employs multiple advanced video rendering technologies, 
that are both platform and hardware dependent. The settings found in the 
options dialog’s “video” pane merely influence if IMF Studio Player requests 
these features. If they are actually available on the system can be seen in the 
IMF Studio Player system info dialog (Press F10). 

  

Vertical Sync (V-Sync): This option should only be enabled, if the video 
rendering suffers from tearing artifacts. Enabling V-Sync will typically negatively 
impact the render performance. 

30 bit colors (Windows only): In order for this option to be available, both 
the graphics adapter and the display need to support it. Within IMF Studio 
Player, 30 bit rendering additionally needs to be enabled or disabled with the 
corresponding option in the “View” menu, e.g. “context menu -> View -> 30 
bit Colors”. 
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Quad-Buffering: (IMF Studio Player only). Also, Mac OS X does not support 
Quad Buffering. Quad Buffering is available, if the graphics adapter supports it 
(e.g. NVIDIA Quadro® series) and stereo is activated in the driver settings. 
When active, left and right images of a stereo source are both passed at full 
resolution to the graphics driver. Within IMF Studio Player, Quad Buffering 
additionally needs to be enabled or disabled in the “2D/3D” menu, e.g. 
“context menu->2D/3D->Quad Buffering” or alternatively by pressing the 
corresponding button in the control bar. 

Background Color: This button allows to pick a custom color for the video 
canvas in order to determine if an asset contains black pillar- or letter- boxes. 

V-Sync Rendering: IMF Studio Player has two render modes: V-Sync-
independent rendering and V-Sync-rendering. 

V-Sync-independent rendering: A good choice if the display runs with 60 Hz or 
more. It is also the fallback option, if V-Sync rendering is not available or not 
enabled. 

V-Sync-rendering: Especially, if the target display is a LCD-TV or a projector, or 
if the maximum refresh rate is significantly lower than 60 Hz (e.g. only 30 Hz), 
then the V-Sync rendering mode should be selected. It can be activated in 
Options -> Video -> V-Sync Rendering (only available if Options -> Video -> 
General -> Rendering -> V-Sync is “currently on”). Even if V-Sync was 
requested, the driver might not enable V-Sync due to other conflicting settings 
in the graphics driver control panel. When you start playback in V-Sync-
Rendering mode, the package's frame rate as well as the display's refresh rate 
will be started in curly brackets next to the "Render" fps line (e.g. "Render (24 
fps @ 24 Hz) in the statistics window. IMF Studio Player will now explicitly 
translate between the package's frame rate and the display's refresh rate, 
which gives best results when both rates are equal or when the display's 
refresh rate is an even multiple of the package's frame rate. 

When using two NVIDIA® graphics cards (e.g. one for rendering and one for 
decoding with CUDA®), it might be necessary to explicitly configure the 
graphics card that should be used for rendering: NVIDIA® Control Panel -> 3D 
Settings -> Manage 3D settings -> Global Settings -> OpenGL rendering GPU -
> <select the graphics card that drives the display where IMF Studio Player's 
canvas is located>. 
This can make a significant difference in terms of render performance. 
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8.2 Audio Rendering 

IMF Studio Player supports multi-channel output. By default the audio output 
device that supports most channels will be selected. Open the audio options 
pane (context menu->Options->Audio tab) for a list of all available audio 
renderers. Supported interfaces are DirectSound (Windows), MME (Windows), 
ASIO (Windows) and CoreAudio (Mac OS X). 

  

Latency: It is possible to specify a latency in milliseconds for each renderer. This 
latency will be taken into consideration when synchronizing audio and video 
frames. Changing the latency will take effect immediately, so it can be easily 
tweaked while simultaneously watching a test package. Except for HD-SDI 
output, the latency should normally be positive, i.e. video output will be slightly 
delayed to compensate for the latency introduced by the operating system’s 
audio processing pipeline. 

Input Channel Order and Output Channel Mapping: Configure the audio 
input channel order and output channel mapping via the graphical user 
interface. To do so select a preset from the existing list or click on the edit 
button next to “Input Channel Order” or “Output Channel Mapping” to define 
own presets. Please refer to chapter 9 for detailed information. 

Multichannel Audio on Apple Systems: IMF Studio Player does not support 
5.1 Audio output using the optical audio ports usually found on Apple 
Computers. Instead, we recommend using the integrated HDMI port or an USB 
Sound Card. 
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8.3 Timed Text 

  

Default Visible Subtitles: A composition may have one or more timed-text 
tracks. Select here which track shall be rendered.  

Subtitle Rendering: On some systems, subtitle outlines are not anti-aliased. 
This effect is noticeable, when multisampling is not enabled. Whether or not 
multi-sampling is enabled can be seen in the IMF Studio Player system info 
dialog (Press F10). On Windows, disabling “Allow 30 bit colors” and “Allow 
Quad-Buffering” might lead to multi-sampling becoming available. 
Alternatively, outlines can simply be ignored by disabling the option “Render 
outlines”. 

Servers behave differently, when it comes to rendering PNG sub-images. 
Toggling the option “Subject PNG sub-pictures to Color Transform” 
specifies if sub-images should also be included in a color transform, i.e. XYZ to 
RGB, or not. 

System Font Fallback: If characters are missing in the loaded font and this 
option is enabled, missing characters will be replaced with characters from a 
similar font. 

Default Online Width: The outline thickness for timed text is not defined in 
the specifications. With this setting, the default outline thickness can be 
configured and will be applied to new Timed Text Tracks.  
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This setting only affects the way timed text is rendered in IMF Studio Player. 
Unless timed text is burnt into the images, this setting will not affect how a 
cinema server renders the outlines. 

 

Timed Text Rounding Mode: The rounding mode influences in some cases at 
which exact frame index a subtitle appears or disappears. 

This setting only affects the way timed text is rendered in IMF Studio Player. 
Unless timed text is burnt into the images, this setting will not affect how a 
cinema server renders the timed text. 

 

Show Forced Display only: Displays only TTML-IMSC1 content elements 
where the computed  value of tts:visibility is “visible”. 

Show Grid borders: Displays a red line around all elements and corresponding 
boxes. 

8.4 HD-SDI Play-out 

  

Enable HD-SDI output: Since version 2.0, IMF Studio Player is capable of 
playing out HD-SDI with the Blackmagic Design UltraStudio, DeckLink and 
Intensity series. Both, PCIe-connected cards and Thunderbolt-connected 
external devices are supported.  
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Thunderbolt devices will only be detected, if they are attached at the time IMF 
Studio Player is started. When enabling HD-SDI output within IMF Studio Player, 
the audio output device should be “ASIO (<name of HD-SDI device>)” on 
Windows and “CoreAudio (<name of HD-SDI device>)” on Mac OS X, so that 
audio and video signals emitted via HD-SDI are in sync. ASIO drivers for 
Windows are available for download at www.asio4all.com. The audio latency 
should normally be negative. 

Advanced HD-SDI related settings can be configured in the Blackmagic Design 
Control Panel.  

Mode: Select a HD-SDI output mode. The frame rate is required to be identical 
to that of the currently playing package. When playing back multiple IMPs with 
different frame rates back to back, the HD-SDI output is not automatically 
adjusted. If the resolution is smaller than the package’s resolution and “Enable 
subtitling, color-processing and scaling” is disabled, images will be cropped. On 
the other hand, if the resolution is larger and the processing option is disabled, 
images will be pillar-/letterboxed.  

Color Depth: Sets the bits per component. 

Levels: Select whether to apply a legal range conversion or not. “Automatic” 
will apply a conversion, if the output format requires it. Alternatively, you can 
select “Convert full-range to legal-range” to enforce the conversion or “No 
conversion” to always skip it.  

Image Processing: If this option is set to OpenGL, images will be scaled to 
meet the currently set-up HD-SDI output resolution. Additionally, the currently 
selected color transform will be applied and subtitles will be rendered. This 
option has significant impact on the render performance. (Enable the statistics 
from “context menu->View->Show FPS stats”) 

Show video also in canvas: Displaying video in the main window while HD-
SDI output is active will impact the render performance and might lead to 
stuttering. Enable this option with care. (Enable the statistics from “context 
menu->View->Show FPS stats”) 

Enable HD-SDI video frame statistics: This option should normally be 
disabled.  
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8.5 Dolby Vision 

 

Enable Dolby Vision Content Mapping: This option affects the rendering of 
Dolby Vision content in video canvas. 

CM config version: Displays the version of the currently loaded CM 
configuration file. The default CM configuration file gets deployed into a sub 
folder of the IMF Studio Shared folder (please refer to chapter 4.3) at the first 
start of IMF Studio Player. If necessary, the default configuration file can be 
changed by modifying the corresponding entry within IMF Studio Player’s 
settings file. The settings file is located in the IMF Studio Player folder (please 
also refer to chapter 4.3). The settings entry key is “CmuConfigFile” and the 
value is the absolute path to the CM configuration file. 

Please be aware that a restart of IMF Studio Player is necessary after the path to 
the CM configuration file was changed. 

 

Mastering Display: After an IMP with Dolby Vision metadata was opened, the 
name of the used Dolby Vision Mastering Display is shown. 

Target Display: Select the Dolby Vision target display which should be used 
for canvas rendering. By default, IMF Studio Player loads all available Dolby 
Vision target displays from the specified CM configuration file. If the currently 
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opened package defines additional target displays, these will be displayed as 
well. 

8.6 Decoders 

  

Within this view it’s possible to configure the devices which should be used for 
playback and export separately. All available devices will be listed under 
“Playback” and “Export”. Refer to chapter 3 for more details on the system 
requirements.  

On most systems, IMF Studio Player is able to automatically configure itself. For 
playback, it attempts to use only the secondary device’s GPUs for JPEG 2000 
decompression and ignore the primary GPU as it will be used for rendering. For 
export, all available GPUs will be selected. 

If no GPUs are available that support the NVIDIA® CUDA® technology, the 
CPU will be used for decoding automatically. 

If you play back a video asset with the GPU-based codec, hit ‘s’ to display 
the performance statistics. The bottom line usually needs to read “GPU 
Decode (1x GPUs)” (unless the CUDA device has two cores like in the 
screenshot above. Then it should be “2x GPUs”). Do not enable a CUDA 
graphics card marked with “(connected to display)”  
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CUDA®-enabled decoders are only available in the Windows version.  

 

8.7 JPEG 2000 

 

Performance vs. Quality trade-off: IMF Studio Player is capable of trading 
some decoding precision for a better performance. Especially, when viewing 
IMPs (which have 12 bit per color) on a regular 24 bit monitor, some 
information from the JPEG 2000 codestream can safely be ignored without 
significantly impacting the resulting image quality.  

The algorithm is designed in a way that the trade-off does not have to be re-
configured for every package. At a certain position, code streams from a IMP 
that contain so many details that they fully utilized the maximum available data 
rate might already be truncated. When subsequently loading a package that 
has only a low data rate, because it does not contain many details, the 
precision would not be impacted, however, because it has a low-rate to begin 
with. This is desirable, because the performance requirements for decoding a 
low-bitrate package is much lower, anyway. 

Make 4K resolution level available: 4K assets can be loaded in a way that 
only a maximum resolution of 2K is available, mainly to save memory and lower 
the performance requirements. Since many displays are not capable of 
rendering 4K anyway and 4K playback has much higher demands on memory 
and hardware, only the 2K part of a 4K JPEG 2000 codestream is evaluated. A 
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4K IMP can also be opened in full resolution by enabling this option. Smooth 
playback requires much more hardware resources. 

Ignore codestream errors, if possible: Being a software-quality tool, IMF 
Studio Player aborts playback as soon as a corrupt JPEG 2000 codestream is 
encountered. This option controls the decoder’s error resilience mode.  

Maximum bitrate violation tolerance: Unless error resilience is enabled, IMF 
Studio Player also checks if the limit is met. Some packages in the field slightly 
violate this limit by a few bytes, which does not seem to cause any playback 
issues. To avoid warning messages in IMF Studio Player, the limit should be 
slightly raised. The default value is 0 bytes. 

8.8 Timeline 

 

Color Space: Configures the target timeline color space which should be used 
for picture thumbnails. This option does not affect the selected target color 
space which is used for rendering in canvas. 
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8.9 Waveforms 

 

When (re-)opening a package the timeline displays the waveform of all 
contained audio tracks. To speed up the waveform generation of an already 
opened package, IMF Studio Player caches previously generated waveforms 
within a repository. Within this options pane the cache directory can be set, 
cleared and restricted to a certain size on disk. 
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8.10 Locations 

 

IMF Studio Creator: Select which installed instance of IMF Studio Creator 
should be used e.g. when an unwrapped IMP should be opened for further 
editing. 

Browse to application settings: Opens the directory on disk where the 
application settings of IMF Studio Player are stored. 

Browse to shared settings: Opens the directory on disk where shared 
application settings of the IMF Studio suite are stored. 
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8.11 Activation Status 

 

All licensing related information and options are part of this options dialog 
view. It’s possible to request or import a license. Furthermore, information 
about the currently imported license can be shown. 
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9 Audio Routing 

Different mechanisms are used to identify audio channels carried in MXF Sound 
Track Files within Interoperable Master Format (IMF) Packages. Playback 
systems rely on such information for eventually outputting sound to connected 
loudspeaker setups. 

This chapter describes configuration options for IMF Studio Player and explains 
routing mechanisms for different package types. 

9.1 Audio Channel Identification 

9.1.1 IMF Packages 

According to SMPTE ST 2067-2 [7], Audio Track Files in IMF Packages are 
required to use Multichannel Audio Labeling, as defined in [3]. 

9.2 Configuration and output behavior 

Within the audio channel order dialog (Options -> Audio -> Edit button next to 
Input Channel Order selection) audio channel maps can be defined. An audio 
channel map describes, what audio channels are contained in a source and 
how they are laid out. The audio input channel order is retrieved from the input 
MXF Sound Track File, if possible. If the audio channels are not labeled in the 
Track File at all, a default channel order is used. 

 

By default, several presets are available. For example “Wildtrack Format/ISDCF 
(HI/VI-N in 7/8)”, which is the most widely used format. New custom presets 
can be created from scratch by clicking  and configuring the channels, or by 
copying and pasting one of the presets' “code” field. The presets tagged with 
a lock cannot be edited, so that they don't get accidentally changed. 
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Output Channel Mapping 

Within the audio channel routing dialog (Options -> Audio -> Edit button next 
to Output Channel Mapping selection) the audio channel mix can be defined. 
An output channel mix describes the currently used speaker setup. It’s possible 
to mix multiple input channels (in the screenshot below the header of the table) 
to the same output channel (e.g. 5.1 to Stereo Downmix, in the screenshot 
below the first column of the table). Optionally, an entire routing can be set to 
lossless. In this case the volume setting takes no effect. Additionally only a 
single input channel can be assigned to an output channel. If the channel 
routing lists more channels than present in the current source, the excessive 
channels will simply be ignored. 

 

By default, several presets are available. New custom presets can be created 
from scratch by clicking  and configuring cells in the table below, or by 
copying and pasting one of the presets' “code” field. The presets tagged with 
a lock cannot be edited, so that they don't get accidentally changed. 
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The available audio channel symbols are listed in the following table: 

Table 1 - Audio channel symbols 

Symbol Description Package Type 
L Left IMF 
R Right IMF 
C Center IMF 
LFE Low Frequency Effects IMF 
Ls Left Surround IMF 
Rs Right Surround IMF 
Lss Left Side Surround IMF 
Rss Right Side Surround IMF 
Lrs Left Rear Surround IMF 
Rrs Right Rear Surround IMF 
Lc Left Center IMF 
Rc Right Center IMF 
Cs Center Surround IMF 
HI Hearing Impaired IMF 
VIN Visually Impaired Narrative IMF 
M1 Mono One IMF 
M2 Mono Two IMF 
Lt Left Total IMF 
Rt Right Total IMF 
Lst Left Surround Total IMF 
Rst Right Surround Total IMF 
S Surround IMF 

 

9.3 Behavior 

If a Sound Track Files signals an audio channel configuration, this configuration 
is taken into account. If not, the configured Input Channel Order is used. 

The output channel configuration is taken from the selected output channel 
mapping accordingly. If the number of channels exceeds the number of 
channels actually supported by the selected output device (e.g. soundcard), all 
channels exceeding this count remain unused. 

If a package contains channels, for which there is no output channel 
configured, these channels are ignored and not played out. Only exceptions are 
Lt/Rt channels, which can be used in IMF packages. If no Lt/Rt output channels 
are specified, they are routed to the L/R output channels (if present).  
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9.4 Configuration and output examples 

9.4.1 Using a standard 2.0/5.1 speaker setup 

For this setup the already available presets should be sufficient. For input 
channel order choose the preset “Default Fallback: Wildtrack Format/ISDCF 
(HI/VI-N in 7/8)”. For output channel mapping use “5.1 to Stereo Downmix” or 
“5.1”. 

The IMP Sound Track File contains the audio channel assignment label #4, 
which indicates “Wild Track Format”. Since this configuration does not specify 
a discrete channel layout, the preset will be used for the number of channels 
present in the Sound Track File. 

The input channels are then routed to the matching output channels, as 
specified in the output channel mapping preset. 

9.4.2 Fixing swapped channels 

Let’s assume the Center channel and the LFE channel are mixed up in your 
output device. In that case, a new output channel mapping preset has to be 
created, based on the already existing one “5.1, 7.1 DS, 7.1 SDDS”. 

Original preset “5.1, 7.1 DS, 7.1 SDDS”: 

 

New preset, where Center and LFE Channel are swapped: 
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10 Command-Line Interface (CLI) 

IMF Studio Player can be used on the command line to perform a hash-check 
on a package. IMF Studio Player additionally provides all options required to 
export or validate a package. For detailed descriptions of the available 
parameters, call the executable file with the parameter “–help”. 

C:\Program Files\Fraunhofer IIS\IMF Studio Player 4.0.0\bin>"IMF Studio Player.com" -h 
 
IMF Studio Player 4.0.0 rev.104669 
 
Usage: "C:/Program Files/Fraunhofer IIS/IMF Studio Player 4.0.0/bin/IMF Studio 
Player.exe" <source> 
 
    A source can be the path to a IMF Package directory, CPL, 
    Assetmap, IMF Studio project file, QuickTime, MXF, J2C, 
    any other supported still image, WAV file or M3U Playlist. 
    Individual audio and video sources need to be separated with a space. 
    When a KDM or digest is required to load the source, just provide it separated by a 
space. 
 
    To display all available export options for an IMF package containing Dolby Vision 
metadata, 
    provide the path to the package as an additional argument. 
    Otherwise the available target displays for export cannot be printed. 
 
Login parameters: 
-username                    Login username - optional if already stored 
-password                    Login password - optional if already stored 
 
Optional parameters: 
-stats                       <statsfile.csv> 
                             Write fps performance statistics to a file. 
-log                         <logfile>|CONSOLE 
                             Enable log and write it to a file or the console 
-hashCheck                   Only perform a hash check 
 
Playback options: 
-play                        Start playback immediately 
-quitAfterPlayback           Close the player after end of first asset is reached 
-quality                     <0 to 100> 
                             specifies the quality for JPEG 2000 playback 
 
Device management: 
Select which devices should be used for playback or export 
-deviceCpuOnly               Use only CPU for decoding 
-deviceGpuOnly               Use most powerful GPU for decoding 

For playback the most powerful GPU will be used, which 
doesn't have a monitor attached 

-deviceId                    <device ID> 
                             Use specific GPU, identified by device id 
 
CUDA devices: 
[1] [CUDA] "GeForce RTX 2080 Ti" (cc7.5, 68 x 128 processors, 11264 MB) 
[2] [CUDA] "GeForce GTX 750 Ti" (cc5.0, 5 x 128 processors, 2048 MB) 
 
Dolby Vision Target Displays: 
[-1]     "None" 
 
Export parameters: 
 
Attention: 
In case an IMF package containing Dolby Vision metadata should be exported, 
all color transform related parameters will be ignored. 
 
 --exportDirectory|-o <path to export directory> 
    Sets the export directory. The directory has to exist. 
 
[--exportType|-t Project|Sequence|Reel] 
    Select export type: 
      Unwrap IMF Studio project 
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      Export a frame sequence 
      Export reels 
 
[--exportFilePrefixMode|-pm CplTitle|PklTitle|Custom] 
    Specify which file prefix should be used for export. 
    "Custom" can be used in combination with -p. 
 
[--exportFilePrefix|-p <export file prefix>] 
    Specify file prefix, e.g. "image_". 
    Options: 
      %1   Current date (yyyy-MM-dd) 
      %2   CPL Title 
      %3   PKL Title 
 
[--exportVideo|-v DPX|TIFF|J2C|MOV|MP4] 
    Select image file format for export sequence. 
 
[--exportAudio|-a MultichannelWAV|WAV|MOV|MP4] 
    Select audio file format for export sequence. 
 
[--exportAudioOutputRouting|-aor] 
    Set the audio output routing preset 
      "5.1, 7.1 DS, 7.1 SDDS" 
      "5.1" 
      "5.1 to Stereo Downmix" 
      "5.1 + HI/VI-N" 
      "5.1 + VIN to Stereo Downmix" 
      "5.1 + HI to Stereo Downmix" 
      "6.1" 
      "6.1 + HI/VI-N" 
      "7.1 DS" 
      "7.1 + HI/VI-N" 
      "7.1 SDDS" 
      "7.1 SDDS + HI/VI-N" 
      "2.0 Stereo" 
      "Lossless passthrough" 
      "HI on all channels" 
      "VI-N on all channels" 
 
[--exportStartIndex|-from] 
    Set start of sequence, 0 is the default. 
 
[--exportStopIndex|-to] 
    Set end of sequence, the last frame is the default. 
 
[--exportStereoMode|-c left|right|leftandright] 
    Select export channel for stereoscopic 3D assets. 
 
[--exportRlvl|-rlvl] 
    Set number of resolution levels to be discarded. 
    Default is 0 for full resolution. 
 
[--exportColorDepth|-bps 8|10|12|16] 
    Select color depth 8, 10, 12 or 16. Default is the original color depth 
    of the video asset. 
 
[--exportColorTransformation|-ct] 
    Set the color transformation XML preset to use. 
    Default is no color transformation. 
      "Brighter for Shutter Glasses" 
      "X'Y'Z' -> R'G'B' (P3)" 
      "X'Y'Z' -> R'G'B' (Rec BT.709)" 
      "X'Y'Z' -> R'G'B' (Rec BT.709) (Brighter for Shutter Glasses)" 
      "X'Y'Z' -> R'G'B' Legal Range (Rec BT.709)" 
      "Y'Cb'Cr' Legal Range -> R'G'B' Full Range (Rec BT.709)" 
 
[--exportSourceColorSpace|-ss] 
    Set the input source color space. If a destination 
    space is selected, a color transformation will be applied. 
      "Eclair Color" 
      "RGB (ITU-R BT.709 Full-Range)" 
      "RGB (ITU-R BT.709)" 
      "RGB P3 (D65)" 
      "RGB P3 (DCI)" 
      "Standard RGB (sRGB)" 
      "XYZ (DCI)" 
      "YCbCr (ITU-R BT.709)" 
 
[--exportDestinationColorSpace|-ds] 
    Set the desired output color space. If an input 
    space is selected, a color transformation will be applied. 
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      "Eclair Color" 
      "RGB (ITU-R BT.709 Full-Range)" 
      "RGB (ITU-R BT.709)" 
      "RGB P3 (D65)" 
      "RGB P3 (DCI)" 
      "Standard RGB (sRGB)" 
      "XYZ (DCI)" 
      "YCbCr (ITU-R BT.709)" 
 
[--exportDolbyVisionTargetDisplayId|-dovitgtdsplyid] 
    Specifies the target display, identified by id, 
    to which the image should be mapped to 
 
[--exportVideoBitrate|-b] 
    Set the desired average video bitrate in kbit/s. 
 
[--exportScaleX|-scaleX <width in pixels>] 
    Set scaled width in pixels. If aspect ratio is different, 
    the remaining pixels will be letterboxed. 
 
[--exportScaleY|-scaleY <height in pixels>] 
    Set scaled height in pixels. If aspect ratio is different, 
    the remaining pixels will be letterboxed. 
 
[--exportFourCC|-fourcc <FourCC>] 
    Set one of the following FourCC codes for MOV, MP4 video export: 
 
    Available codecs for container "MOV": 
      "mpeg1video" (MPEG-1 video) 
      "mpeg2video" (MPEG-2 video) 
      "mpeg4" (MPEG-4 part 2) 
      "dnxhd" (VC3/DNxHD) 
      "prores" (Apple ProRes) 
      "h264" (H264) 
 
    Available codecs for container "MP4": 
      "mpeg1video" (MPEG-1 video) 
      "mpeg2video" (MPEG-2 video) 
      "mpeg4" (MPEG-4 part 2) 
      "h264" (H264) 
 
[--exportVideoOutputProfile|-videooutputprofile <Profile>] 
    Set one of the following profiles when using Apple Prores or H264 codec for video 
export: 
 
    Available profiles for Apple ProRes: 
      "apco" (Apple ProRes 422 Proxy) 
      "apcs" (Apple ProRes 422 LT) 
      "apcn" (Apple ProRes 422) 
      "apch" (Apple ProRes 422 HQ) 
      "ap4h" (Apple ProRes 4444) 
      "ap4x" (Apple ProRes 4444 XQ) 
 
    Available profiles for H264: 
      "baseline" (H264 Baseline) 
 
[--exportAudioFourCC|-audiofourcc <FourCC>] 
    Set one of the following FourCC codes for MOV, MP4 audio export: 
 
    Available codecs for container "MOV": 
      "aac" (AAC (Advanced Audio Coding)) 
      "alac" (ALAC (Apple Lossless Audio Codec)) 
      "pcm_s16le" (PCM signed 16-bit little-endian) 
      "pcm_s16be" (PCM signed 16-bit big-endian) 
      "pcm_s32le" (PCM signed 32-bit little-endian) 
      "pcm_s32be" (PCM signed 32-bit big-endian) 
      "pcm_s24le" (PCM signed 24-bit little-endian) 
      "pcm_s24be" (PCM signed 24-bit big-endian) 
      "pcm_f32be" (PCM 32-bit floating point big-endian) 
      "pcm_f32le" (PCM 32-bit floating point little-endian) 
 
    Available codecs for container "MP4": 
      "aac" (AAC (Advanced Audio Coding)) 
 
[--exportBurnInSubtitles|-burnsub] 
    Burn in subtitles. 
 
[--exportBurnInSubtitlesVOffset|-burnsubvoffs] <offset 0-100> 
    Set additional vertical offset from bottom in procent 0-100. 
 
[--exportBurnInSubtitlesType|-burnsubtype] 
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    Set one of the following codes: 
      "OpenSubtitle" 
      "MainSubtitle" 
      "ClosedSubtitle" 
      "OpenCaption" 
      "MainCaption" 
      "ClosedCaption" 
      "MainClosedCaption" 
 
[--exportBurnInSubtitlesLanguage|-burnsublang] 
    Set specific language of subtitle. 
    None (default) means all available languages for the given type are used. 
 
[--exportBurnInTimecode|-burntc] 
    Burn in time-code. 
 
[--exportBurnInTimecodeVOffset|-burntcvoffs <offset 0-100>] 
    Specify vertical offset from bottom in procent 0-100. 
 
[--exportBurnInTimecodeColor|-burntccolor <color e.g. "red", "#RGB", "#RRGGBB">] 
    Set color for burning-in time-code. 
 
[--exportBurnInTimecodeFont|-burntcfont <color e.g. "arial">] 
    Set font for burning-in time-code. 
 
[--exportBurnInTimecodeFontSize|-burntcfontsize <font size in points>] 
    Set font size for burning-in time-code. 
 
[--exportBurnInText|-burntxt <text>] 
    Burn in static text, e.g. "property of Fraunhofer IIS". 
 
[--exportBurnInTextVOffset|-burntxtvoffs] <offset 0-100> 
    Specify vertical offset from bottom in procent 0-100. 
 
[--exportBurnInTextColor|-burntxtcolor] <color> 
    Set color for burning-in text. 
    Format can be "red", "#RGB" or "#RRGGBB" 
 
[--exportBurnInTextFont|-burntxtfont] <color e.g. "arial"> 
    Set font for burning-in text. 
 
[--exportBurnInTimecodeFontSize|-burntcfontsize] <font size in points> 
    Set font size for burning-in text. 
 
 
Validation parameters: 
 
 -validate 
   Performs a validation of the provided package. 
 
[--reportFile|-o <report.html>] 
    Sets the path for the output file of validation. The directory has to exist. 
 
    If the path is a directory, the package's folder name will be used as file base name. 
 
    This way, all reports for a validation batch job can be conveniently stored in a 
single folder. 
 
[--comment|-c <comment>] 
    Write a custom comment to the quality report. 
 
[--tests|-t <"1,2,3">] 
    List of tests which should be executed. If no tests are selected, all available tests 
will be executed. 
 
    Mutually exclusive with -skipTests. 
 
[--skipTests|-s <"1,2,3">] 
    List of tests which should not be executed. All other tests will be enabled. 
 
    Mutually exclusive with -tests. 
 
    Available tests: 
     Id Name 
     1  File Sizes 
     2  XML files' digital signature 
     3  XML Schema 
     9  File Hashes 
     10 File Hashes (small files only) 
     11 JPEG 2000 Code Streams 
     12 JPEG 2000 Code Streams (probe only) 
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     13 JPEG 2000 Bit Rate 
     14 Audio Buffers 
     15 Digital Cinema Naming Convention 
     16 Package Title 
     17 Consistent Trackfiles 
     18 XML Format 
     19 Fonts/PNGs Listed in Package 
     20 Out of Bounds Timestamps 
     21 Characters Available 
     23 Fonts/PNGs Available 
     24 Order of Time-in Timestamps 
     25 Order of Timed Text Spot Numbers 
     26 Open Subtitles Language 
     27 Subtitle Burnin Overlap 
     28 Number of Compositions 
     29 Conformity 
     30 Output Profile List 
     31 Issuer Language 
     32 Timed Text Usage 
     33 Frame Rate Conformity 
     34 Frame Rate Limit 
     35 Subtitle Multi Usage 
     36 Digital Cinema Naming Convention 
     37 Audio Language Codes 
     38 Track Edit Rates 
     39 Track Frame Rates 
     40 Subtitle Display Type 
     41 Subtitle Language 
     42 Resolution 
     43 Image Subsampling 
     44 Source Colorspace 
     45 Audio Channel Configuration 
     46 Audio Sampling Rate 
     47 Audio Bits 
     48 JPEG 2000 Properties 
     50 Number of Sequences/Tracks 
     51 Sequence Durations 
     52 Sequence Edit Rates 
     53 Subtitle Burn-in 
     54 Subtitle Display Type 
     55 Subtitle Language 
     56 Subtitle Multi Usage 
     57 Dolby Atmos 
     58 Sequence Duration 
     59 Audio Sequence Duration with NTSC Frame Rates 
     60 Number of Entries 
     61 Sound Language Code 
     62 Intrinsic Duration 
     63 Frame and Edit Rate 
     64 Frame and Edit Rate Metadata 
     65 Picture Track Subsampling 
     66 Resolution 
     67 Track audio padding 
     68 Subtitle Track Source Document 
     69 Subtitle Track Conformity 
     70 Subtitle Track Schema Check 
     71 Subtitle Track Semantics Check 
     72 Subtitle Track Edit Rate 
     73 Subtitle Track Resource 
     74 Subtitle Track Encryption 
     75 Subtitle Entries After Picture 
     76 Frame Rate Conformity 
     77 Subsampling Resolution 
     78 Dolby Vision Metadata 
     79 Dolby Vision Metadata Supplemental 
     80 Equal Sound Count 
     81 CPL contains Reel 
     82 Contains CPLs 
     83 Parsing OPLs 
     84 Max Path Length of Package Files 
     85 Valid color processing configuration 
     86 Valid subsampling configuration 
     87 Check for valid CPL metadata 
     88 Check for CPL metadata extension sign language video 
     89 JPEG 2000 Component Bit Rate Recommendation 
     90 Subtitle Track ReelNumber 
     91 SMPTE Subtitle Namespace Prefix 

  



 
 

 72 of 77 23/02/2021 
 
 

 

10.1 On Windows 

On Windows, the command prompt or a script (e.g. a batch file) would 
typically be used pass command line parameters to IMF Studio Player. IMF 
Studio Player.exe / IMF Studio Player.exe were built using the Windows 
Subsystem and therefore their output is not visible in the command prompt. 
Instead, IMF Studio Player.com / IMF Studio Player.com should be used. Since 
the executable file contains a space, enclose any calls into “”, e.g.  

C:\>”Program Files\Fraunhofer IIS\IMF Studio Player 4.0.0\bin\IMF Studio 
Player.com” –help 

 

10.2 On Mac OS X 

On Mac OS X, the terminal or a script (e.g. a shell script) would typically be 
used to pass command line parameters to IMF Studio Player. The IMF Studio 
Player application is in truth a directory called “IMF Studio Player.app”. The 
executable file which can be started and passed parameters is “IMF Studio 
Player.app/Contents/MacOS/IMF Studio Player”. Since the executable file 
contains a space, enclose any calls into “”, e.g. 

Mymac:~ user$ “/Applications/IMF Studio Player 4.0.0.app/Contents/MacOS/IMF 
Studio Player 4.0.0” -h 
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11 Limitations 

11.1 IMPs 

Resolutions higher than 4K are not supported. 

11.2 Timed Text 

Rendering of IMF subtitles (TTML / IMSC) is an experimental feature.  
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12 Frequently Asked Questions (FAQs) 

please refer to FAQs at www.easydcp.com 
  



 
 

 75 of 77 23/02/2021 
 
 

 

13 Disclaimer 

The fact that IMF Studio Player is able to playback a media asset, e.g. IMF, does 
not guarantee that another piece of software, regardless which vendor, will 
also playback the asset. 

IMF Studio Player is designed to be a quality control tool. 
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14 Contact 

We appreciate very much to have your feedback and your annotations about 
IMF Studio Player. In order to enhance the software and to optimize it for your 
applications, we are looking forward to your cooperation. 

If you have any problems or questions, please contact us at the following 
addresses: 

 

Sales & Technical Support 

easyDCP GmbH 
Eiblwiesweg 2 
82418 Murnau, Germany 
info@IMF Studio.com 

 

Product Management 

Fraunhofer Institute for Integrated Circuits IIS 
Department Moving Picture Technologies  
Heiko Sparenberg 
91058 Erlangen, Germany 
heiko.sparenberg@iis.fraunhofer.de 
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